
 

 



 

INTRODUCTION 
Welcome to the PUB LOG FLIS Search Users Manual.   

This software is the integration of multiple database sources.  These databases 
are mastered together into a single cohesive interface available through the web.  

This manual is organized into the following sections to help you understand the 
structure of the software: 

• Introduction 

• Query 

• Picklist 

• View 

Using this Manual 
This manual is organized to give you a basic understanding of how the software 
functions are performed. Within this manual, please note the following:  

[Button] Button (i.e., “OK”, “Next”, “Back”, “Cancel”, “Close”, etc…) 

<Field> Field (i.e., titles/text for radio button options, checkbox 
options, “fill-in” text boxes, drop-down list boxes, etc…) 

<Default Field> Default option italicized 

Hyperlink Hyperlink (to Internet or within manual) 

 

 

Menu Bar 
Within the software, a menu bar is provided during this application for quick 
access to commonly used commands. If you do not have a mouse available, any 
of these menu items can be accessed by pressing the Alt key and by either typing 
the first letter of the menu item or by using the arrow keys to select the desired 
command. The global menu items are listed below. The available menu items 
specific to section (Query, Picklist, and View) are listed at the beginning of each 
sections. 

File Menu 
The “File” Menu pertains to commonly used commands… 

• Page Setup 
This option opens the Page Setup Dialog Box. 

• Print 
This option opens the Print dialog box. 
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• Exit 
This option exits the application. 

• Load Query (*Available Only While in QUERY Screen) 
If you choose “Load Query”, this window will open where you can navigate 
to a pre-existing Query file (.qry). Select and click [Open]. 

• Save Query (*Available Only While in QUERY Screen) 
If you choose “Save Query”, this dialog box will appear where you can 
select your desired filepath and filename to save your Query for later 
access. 

• Save as 
If you choose “Save as” while you are viewing the Picklist screen, you 
will have the option to save this Picklist as a comma-delimited file 
(*.csv) to a filepath and filename of your choice. If you choose “Save as” 
while you are in the View screen, you can save this View as a HTML file 
(*.htm) to a filepath and filename of your choice. 

Sort By Menu (*Available Only While in PICKLIST Screen) 
The “Sort By” Menu contains all Table headers. You can also click on the Table 
header itself to Sort Ascending. 

Views Menu (*Available Only While in VIEW Screen) 
The “Views” Menu provides quick access to the available view options. Please 
note there are also subView options available. 

Help Menu 
The “Help” Menu contains options in the event that you need more information 
on how to utilize this software. 

• Context Help 
“Context Help” opens the Context Sensitive Index Help described in this 
section. 

• Manual 
“Manual” links to a PDF document of this help manual. 

Context Sensitive Help 

 

Selecting the Help menu and the Context Help option will bring up the Index Help 
dialog box where you can search for further information on the desired field. You 
can choose from the following tabs:  

• Index 
If you would like to use the Index feature, type in the box provided to jump 
to the record(s) starting with the characters you type. You can also select 
multiple Index fields by selecting the first and holding your Control key 
while selecting others; all descriptions will appear in the screen on the 
right-hand side. 

• Search 
Use search if you would like to manually type related keywords that you 
would like to search on. After highlighting your selection, press 
[Display] to display your results. After you have found the information 
you are looking for, press [Close] to return to your previous screen. 

From the list of topics found on the left side of the screen, use the scroll bar to 
choose the records that you would like to search for. A selected record is 
highlighted in blue. To select multiple consecutive numbers, click the first record 
and while pressing down your Shift key, click the last record in the series. To select 

2 | P a g e  



 

multiple non-consecutive numbers, click the first record and press the Control key 
while selecting the remainder. 

Note that by choosing multiple values, you will be searching using a Boolean “OR” 
search, meaning that all values will be shown that match your criteria. 

• [View Reg] 

The [View Reg] option is only available if there are one or more URLs within 
the text. If the option is available, you can use this feature to jump to it 
directly. 

Screen Size 
You can change the size of the “Picklist” and “View” screens at your discretion by 
mousing over the edges of the screen and clicking and dragging the arrow that 
appears. 

Ok. Let’s get started… 
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QUERY 
The Query portion of the search process allows you to search on specified data 
set(s). You can press [Clear] at any time to start from a blank screen. 

This screen contains different Views (as shown below) to choose from and each 
tab has a specific set of searchable fields. 

 

Choose the tab and field you would like to search on. Type your criteria in the space 
allotted next to the field and click [Search]. Drop-down lists contain previously 
used query values and can be displayed and selected by clicking on the down 
arrow to the right of the field. The application retains up to your last 20 searches. 

If you are searching for multiple values, enter the criteria in the fields (separate 
each value with one space) and press [Search]. Please note that all queries use 
a Boolean “AND” search (opposed to “OR”). For example, if you were to choose 
Field#1=B; Field#4=12, it would pull all records that match both criteria. 

 

You may also search using the <Find It> feature. When you search within the Find 
It field, you are searching for the criteria in all fields. Use this option when you are 
unsure what type of data you have. When the software has found your results, you 
will see Find It dialog box as shown above. Select which field you would like to filter 
the criteria by and click [Picklist] to continue. 
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Indexed Browse 

 
If you click on one of the field name buttons, you will enter the “Indexed Browse” 
screen for that field. The example shown above displays the Indexed Browse 
screen after clicking on a field button. This screen gives you detailed options for 
the field you are searching on. 

Typing in the box above the scroll items will jump to the record(s) starting with the 
characters you type. 

Pressing [Help] will bring up the Index Help dialog box where you can search for 
further information on the desired field. 

• Clicking [Save List] will bring up a Save As dialog box. This selection will 
save a text file of all values shown on this screen. Choose the location 
where you would like to save this query, name it appropriately, and click 
[Save]. 

• Clicking [Save Selected] will also bring up a Save As dialog box (above). 
This selection will save a text file of only the selected values shown on 
this screen. Choose the location where you would like to save this query, 
name it appropriately, and click [Save]. 

 
Press [OK] once you have selected all of your records. After clicking [OK], you 
will be back to the Interactive Query screen and your chosen values will be shown 
in the desired field, each separated by one space as shown above. You will also 
notice that depending on which field you are querying, some of the fields may now 
be unavailable. From here, you can choose to perform a combination search for 
other criteria on the “available fields”.  After your search criteria is complete, press 
[Search]. 

Please note that all queries use a Boolean “AND” search (opposed to “OR”).  For 
example, if you were to choose Field#1=B; Field#4=12, it would pull all records 
the match both criteria. 
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Search Results 
• If your search results in one individual item, the Picklist portion of the 

database will be skipped and you will go directly to the View screen. 
Please go to the View section of this manual for further instruction. 

• If your search results in multiple items, you will go directly to the Picklist 
screen. Please go to the Picklist section of this manual for further 
instruction. 

• If your search results in no matches, please modify your search. 
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PICKLIST 

 

The Picklist presents you with the results from your query. The figure above shows 
an example of the Picklist screen. Above the scroll list, you can see how many 
matches are within your results and also keep track of how many you have 
“tagged”. From this screen, you can narrow your results even further. 

If you would like to use the “Find” feature, enter your search criteria and press the 
[FIND (F3)] button or just press “F3” on your keyboard to refine your search. If you 
press “F3”, it will jump to the next record within your criteria. 

 

Columns 
The columns in your Picklist are those where boolean options are available from 
the query screen.  All columns can be easily sorted (alphabetically) by clicking on 
the column headings. Once the column is sorted, you can press any letter key and 
it will jump to the first record that starts with the letter within the sorted column. 
Use the scroll bar at the bottom of the screen to view all available columns. You 
can also change the column width by clicking between the column headings and 
dragging your mouse to the left or right to increase or decrease the column width.  
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If you right-click a field within the Picklist, a submenu will appear (above) that will 
give you the option to Copy this row, Copy selected rows, Copy this column, Save 
this list to a file, Search “(selected field)”, Tag all “(selected fields)”, Remove all 
matches with “(selected field)”, or Keep only those matches with “(selected field)”. 

Narrowing your Selection 
If you would like to see the results for all records listed, click the check box heading 
(first column) at the very left of the screen to select all records. Once all are 
selected, the checkbox heading will be unchecked. Recheck to deselect all 
records. You can also use the [Tag/Untag all] button to do this. 

If you would like to choose your selection(s) manually, scroll down and check the 
box next to each record you would like to see. 

Save 

If you click [Save], a dialog box will appear. Here, you have the option of saving 
the results as a .csv file (comma-delimited text file). Navigate to the folder you 
would like to save the file and click [Save]. 

View(s) 
If you click [View], your results will appear in the View format within the software. 
Please continue to the next section for more guidelines. 
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If any view has no data for any table, the message “There is no data available for 
this view” will appear.  If you go to File\Properties and check the checkbox next to 
“Show Blank Tables”, this message will not appear. 

If you check the box next to <Highlight query text>, all criteria that you initially search 
for will be highlighted in your results in your color of choice. 
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VIEW 

 
The “View” Screen (above) contains all information for one individual record. One 
or more tables can be associated with a View for each record. Above the tabs, you 
will see the record that you are currently viewing. Use the arrows to go to other 
records. 

If more than one match is tagged and you are sure one of the matches is not what 
you’re searching for, click the “Untag” button when on the undesired record. 

If data in tables is blue and underlined, this means the field is “linked” and will 
launch Context Help. 

If you would like to create a New Search, click the [New Search] button or use 
the shortcut and press the letter “S” on your keyboard. 

Print Results 

 
Go to File Menu – Print to print your results. (above). 

1. <Records to print> 
Choose to print either all Tagged records or only the current record. 

Print/Page Setup 
Page Setup is where you determine the printed report parameters as defined 
below: 
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Output 

 
The figure above displays the Print/Page Setup screen with the “Output” tab 
selected. You can do one of three things on this screen: 

1. <Printer> 
Select desired available printer 

2. <Orientation> 
The orientation can be “portrait” or “landscape,” depending on which 
works best to view your data. If there are a lot of columns, landscape is 
probably your best choice. 

3. <Adjust to _ % normal size> 
This feature scales the size of output. This option is commonly used in 
order to fit results with many columns/fields on a limited amount of pages. 

Page 

 
The figure above displays the Page Setup screen with the “Page” tab selected. You 
can do one of three things on this screen: 

• <Margins> 
The size of the area between the edge of the paper and the printed data 

• <Orientation> 
Orientation refers to the placement of the Rubber Stamp text on each 
page of your printed results. 

• <Pages> 
You can choose to display the Rubber Stamp on any combination of the 
following:  First Page, Middle Page(s), Last Page. 

• <Rubber Stamp> (i.e., signature blocks) 
You can enter three lines of text, specify where they should go and which 
page(s) should contain them. If you would like to include a graphic image 
on your rubber stamp, enter "#I=(your file).jpg". 

Once you have chosen your settings, press [OK] which will take you back to the 
main Print screen. Press [Print] to print your results.  
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